Research article / Научная статья

Natural Language Processing and Fiction Text: Basis for Corpus Research

Alexey I. Gorozhanov¹, Innara A. Guseynova¹, Darya V. Stepanova²

¹Moscow State Linguistic University, Moscow, Russian Federation
²Minsk State Linguistic University, Minsk, Belarus

✉a_gorozhanov@mail.ru

Abstract. The study deals with NLP procedures on the material of the fiction texts in German and in English, which are considered as strong cultural texts. The aim of the study is to develop a model of such a technical device to process, analyze and interpret a fiction text, which would reveal the full potential of popular NLP tools within the corpus approach. The general methods used in the study are analysis and synthesis. Special methods are additionally used to solve certain specific issues: descriptive method, modelling and qualitative and quantitative analysis. The scientific novelty lies in the fact that the authors apply the crucial principles of the classical theories of text interpretation according to the latest methods and tools of the applied linguistics. As a practical result, special software has been developed, which is able to process SQL based linguistic corpora, automatically built with spaCy NLP library and Python programming language. This software can be used for a fiction text interpretation, as well as for compiling learning materials in Home Reading. It is assumed that the development of special software for strong cultural texts stimulates the search for scientific solutions and at the same time allows one to understand the essential differences that exist between natural and artificial intelligence.

Keywords: natural language processing, fiction text, linguistic corpus, F. Kafka, J. London, applied linguistics, spaCy

Article history:
Received: 01.09.2023
Accepted: 15.12.2023

For citation:

© Gorozhanov A.I., Guseynova I.A., Stepanova D.V., 2024
This work is licensed under a Creative Commons Attribution 4.0 International License
https://creativecommons.org/licenses/by-nc/4.0/legalcode
Обработка естественного языка и художественный текст: база для корпусного исследования

А.И. Горожанов1✉, И.А. Гусейнова1, Д.В. Степанова2

1 Московский государственный лингвистический университет, Москва, Российская Федерация
2 Минский государственный лингвистический университет, Минск, Республика Беларусь
✉ a_gorozhanov@mail.ru

Аннотация. Рассматриваются процедуры обработки естественного языка (NLP) на материале художественных текстов на немецком и английском языках, которые рассматриваются как сильные культурные тексты. Целью исследования является разработка модели такого инструмента обработки, анализа и интерпретации художественного текста, который раскрывал бы весь потенциал популярных инструментов NLP в рамках корпусного подхода. Общими методами, используемыми в исследовании, являются анализ и синтез. Для решения отдельных задач дополнительно применяются специальные методы: описательный метод, моделирование и качественно-количественный анализ. Научная новизна заключается в том, что авторы совмещают основополагающие принципы «классической» теории интерпретации текста и новейшие методы и инструменты прикладной лингвистики. В результате было разработано специальное программное обеспечение, способное работать с лингвистическими корпусами на основе баз данных SQL, автоматически построенными с помощью библиотеки spaCy и языка программирования Python. Созданное приложение можно использовать для интерпретации художественного текста, а также для составления учебных материалов для дисциплины «Домашнее чтение». Предполагается, что разработка специального программного обеспечения для сильных культурных текстов стимулирует поиск научных решений и в то же время позволит понять существенные различия, существующие между естественным и искусственным интеллектом.

Ключевые слова: обработка естественного языка, художественный текст, лингвистический корпус, Ф. Кафка, Дж. Лондон, прикладная лингвистика, spaCy

История статьи:
Дата поступления: 01.09.2023
Дата приема в печать: 15.12.2023

Для цитирования:

Introduction

The context of this applied study is shaped by the fields of natural language processing (NLP), corpus linguistics and more widely — computational linguistics, which are often overlapping each other throughout their development or related to one other as part-to-whole [1]. In fact, today NLP and corpus linguistics are found in increasing proportion within the same research projects, as evidenced by numerous publications from high-rank scientific journals.

For example, NLP libraries can be used for text mining in the digital corpus of books [2]. Fonseca et al. [3] apply NLP tools along with the linguistic corpora based on the XML tagging, analyzing the genre compositional structure. The NLP
tools are also used for automated text analysis of a large corpus of journal articles. The authors come to the conclusion that ‘the creation of such corpora ... can lead to more valid and reliable analysis of historical texts and thus contribute to the deeper understanding of different historical eras’ [4. P. 13].

The increasing use of NLP tools by corpus researchers is understandable. On the one hand, a linguistic corpus is a very powerful tool for language research, especially when it comes to functional comparability and identifying differences in the use of individual linguistic phenomena [5]. On the other hand, building a corpus is an extremely time-consuming task that requires a large amount of human and material resources. In addition, the linguistic corpus is not always a flexible tool. In other words, its parameters must be determined once and for all, since it is not practical to change the rules of the game at the moment when several million tokens have been staked. In this regard, there arises a natural need to build a functional linguistic corpus in a fully automatic mode, at least in order to test the parameters one has chosen and change them quickly if necessary.

An example is our previous study, in the framework of which an original corpus editor, a special grammatical corpus was built for E.M. Remarque’s novel “The Night in Lisbon”. The XML tagging was applied. The basic token of the corpus was a sentence, in which the presence of certain grammatical features was marked: the mood, the tense and the voice for the verbs, degrees of comparison for the adjectives, the case for the prepositions, etc. The problem was that once the text of the novel had been completely marked up, it would have been impossible to introduce a new feature without having to do all the work again, sentence by sentence [6].

A linguistic corpus, as a collection of texts, reflects the phenomenon of a certain historical period of time. However, among such texts one can distinguish the so-called strong and weak cultural texts. Strong texts have philological vitality that let them exist for centuries in different cultures [7]. The strong texts rightly refer to fiction and poetry. Weak texts exist hic et nunc; they translate current knowledge data. These texts contribute to the development of terminological systems, as well as the promotion of innovations and modern goods and services. In our research, we focus on strong texts of the world culture that require analysis and interpretation.

The aim of this study is to develop a model of such a technical device for the analysis and interpretation of a fiction text, which would reveal the full potential of popular NLP tools within the corpus approach.

To achieve this, it is necessary to solve the following tasks:
1) to describe the potential of one of the most popular NLP libraries for the fiction text processing;
2) to determine the corpus parameters of the research, i.e. to answer the question to what extent the corpus approach will be applied;
3) to build a model of a technical device for creating and managing a structured fiction text bank (corpus);
4) to develop and test a beta version of a GUI application.
The scientific novelty of the study lies in the fact that we apply the crucial principles of the classical theories of text interpretation in conjunction with the latest methods and tools of the applied linguistics.

**Material and Methods**

The study material can be divided into two major groups. The first group represents the linguistic material and includes the German texts of the three novels written by Franz Kafka: “The Castle”, “The Trial” and “Amerika”, and the English texts of Jack London’s series of stories “Smoke Bellew. Smoke and Shorty”. So, it is what we actually study from the linguistic point of view.

Despite of the fact that F. Kafka’s novels were written almost 100 years ago, they do not lose their relevance both in terms of the content and in terms of the linguistic material [8–10]. The work by J. London is also still of interest to many linguists and specialists in literature, who see great potential in the texts of this writer for analysis and practical use in their professional fields [11–13].

The works of F. Kafka and J. London can be rightfully ranked among the strong texts, which are able to integrate different cultural traditions of fiction. At the same time, they represent *complexity*, since the software tools for their interpretation must correspond to the uniqueness of strong texts, and *ease*, since these texts are relevant for different cultures and are aimed at integrating common knowledge among representatives of the different ethnic communities.

The second group describes several technical tools, such as Python programming language, SQLite database, PyQt GUI library and spaCy NLP library. It is through what we come to the study of the linguistic material. Today Python is a leading powerful digital tool that is used not only to solve scientific issues, but also in programming in general. The SQLite database can be connected to stand-alone applications, as the PyQt GUI library is a tool for creating graphical interfaces with Python to use them beyond the world wide web. The latter is very popular and is applied in many research projects [14–16].

SpaCy NLP library was released about eight years ago, and now it is a widely used toolkit for processing texts in 23 languages. The accuracy of the procedure is quite high, especially for the English language. However, there are groups of researchers who are trying to improve the accuracy of the library and compare its effectiveness with similar products: StanfordNLP, NLTK, OpenNLP, etc. [17].

The general methods used in the study are analysis and synthesis. Special methods are additionally used to solve specific individual issues: descriptive method for tasks 1 and 2, modelling for task 3 and qualitative and quantitative analysis [18] for task 4.

---

1. see TIOBE Index for April 2023: https://www.tiobe.com/tiobe-index.
2. spaCy Models & Languages: https://spacy.io/usage/models#languages.
Theoretical Background

The field of description and interpretation of a fiction text as a branch of the linguistics has its long tradition and is based on the works by a number of scientists. The theoretical basis of our study is formed by the works of the representatives of the Russian school of German studies: O.I. Moskalskaya, E.V. Gulyga, E.I. Shendels, L.A. Nozdrina, Y.M. Kazantseva, etc. [19. P. 90–92].

The above-mentioned researchers paid much attention to the issues related to theoretical grammar, interpretation of (fiction) texts, analysis of the elements of philosophical and grammatical concepts as text-forming categories. In the field of computational linguistics, the most important studies for us were conducted by R.K. Potapova [20] and A.V. Zubov [21]. Considering the fundamental classics, we simultaneously apply in our research the achievements of modern scientists from the field of corpus linguistics and NLP. Thus, we will be able to combine traditional interpretation methods with the modern software tools to achieve objective results.

In modern scientific publications dedicated to using spaCy NLP library in corpus research, as well as to processing unordered text arrays, we can highlight several areas. A large number of research projects are devoted to building ready-made software solutions using spaCy [22–25]. Usually this library is used as a software tool without making a special graphical interface, e.g., for automatic text summarization [26] or information extraction from different file formats [27]. A slightly different way is to develop the functionality of the library or to add new languages to it [28; 29]. Many researchers solve highly specialized tasks with the help of the library. So, Soni and Rambola [30] use spaCy for aspect-level sentiment analysis and opinion mining. Chantrapornchai and Tunsakul [31] present two machine learning-based methodologies used to extract particular information from full texts about restaurants, hotels, shopping, and tourism. Singh et al. [32] detect named entities from sentences written in the Punjabi language’s Gurmukhi script. This list can be continued with other relevant items. Furthermore, we rely on the results of our own research in the field of corpus linguistics and text interpretation in which we aim to get a synergistic effect through a combination of precise tools and mental interpretation [33; 34].

Study and Results

To solve the first task of our study, it was necessary to understand what exactly spaCy library was able to offer for the fiction texts analysis. First of all, it should be mentioned that the library is not a ready-made software and can be used in its original form by Python programmers only. This condition makes its usage difficult for a wide range of the linguists who do not have programming skills.

The most important spaCy tools are the following: sentencizer, tokenizer, lemmatizer and morphologizer. This means that the library is able, firstly, to parse the text into sentences and tokens. Secondly, for each of the tokens the library determines a particular part of speech it refers to. And thirdly, for each token, spaCy determines its morphological attributes and their values and the initial form of the
word — a lemma (e.g. an infinitive for a verb or a singular nominative form for a noun, personal pronoun, etc.).

At the next stage of the study, it was necessary to understand to what extent we would use the corpus approach, and what exactly that could mean. As we have already singled out the difficulties that are associated with creating a corpus in the classical sense, that is, using manual mark-up. However, since we applied a corpus approach, we determined that the tool for studying linguistic phenomena in the fiction texts should be a linguistic corpus. As a result, we chose a linguistic corpus, created in a fully automatic way. Nevertheless, this alone did not give an understanding of what the corpus we needed would look like.

In fact, it was necessary to make a choice between two options: the XML mark-up or the SQL mark-up. The first option was convenient, because the XML database can be read by human. But in the course of our research, we came to a conclusion that the XML files were rather “bulky” and working with them was not as convenient as working with the SQL files, though the SQL data base for a novel was larger than the XML database of the same fiction work.

The structure of our SQL database as a relational database can be represented in the form of two tables: one for the sentences (Table 1).

<table>
<thead>
<tr>
<th>Database table for the sentences</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td>integer</td>
</tr>
</tbody>
</table>

And one for the tokens (Table 2).

<table>
<thead>
<tr>
<th>Database table for the tokens</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td>integer</td>
</tr>
</tbody>
</table>

The both tables are related through the sentence number, so for each token one can track its sentence. The cell TOKEN ATTRIBUTES AND VALUES deserves special attention, since the attributes and their value are listed there all at once, and not distributed between the cells. This somewhat simplified approach can be justified by the fact that different tokens can have a different number of attributes, so there cannot be the same number of cells in a row for all tokens. For example, for a verb it looks like:

\[ \text{Mood=}\text{Ind}|\text{Number=}\text{Sing}|\text{Person=}3|\text{Tense=}\text{Past}|\text{VerbForm=}\text{Fin} \]

and for an adjective:

\[ \text{Case=}\text{Acc}|\text{Degree=}\text{Pos}|\text{Gender=}\text{Fem}|\text{Number=}\text{Sing} \]
The pair attribute & value is separated by a vertical bar without spaces.

The experimental SQL databases (like all applications mentioned in this paper as our own) were generated automatically by a Python CLI application, which was developed in the Laboratory for Fundamental and Applied Issues of Virtual Education at Moscow State Linguistic University. As a basis, the TXT files of the novels were taken, which had been previously slightly formatted.

So, we opted for Python as a programming language, SQLite as a database and PyQt as a GUI library, not to mention spaCy as an NLP library. The main requirement that the corpus manager was supposed to suit was that it had to be flexible. The idea was that the developer can quickly alter it, and that related also to the graphical user interface. Here we relied on the concept of rapid application development (RAD) that ‘has become a major trend in the field of software development’ [35. P. 1].

To meet these requirements the graphical shell of the corpus manager had to be developed in a separate file, as a Python class, and all programme logic was included into the main Python programme file, in which the graphical class was imported as a module. The graphical shell was created in Qt Designer, which generated Python class code automatically. From this file the developer got GUI objects names to refer to them in the main file. As a result, we were able to make changes to the graphical shell (location of objects, colours, etc.) without having to modify the main file.

Having determined the structure of the linguistic corpus and the methodology for its development, let us turn to the programming logic as a set of functions in the main file, which are expected to perform specific tasks, e.g., clear the output area or close the application.

These tasks are the following:

1) open a new linguistic corpus;
2) output a frequency list of all lemmas, from the most frequently used to the least frequently used;
3) output the given sentence in the context of several sentences;
4) output all sentences containing the given lemma;
5) output all sentences containing the given list of lemmas (e.g. ‘Dorf’, ‘Schnee’, ‘kalt’);
6) output all sentences containing the given token;
7) output all sentences containing the given list of tokens (e.g. ‘Dorfes’, ‘Schnee’, ‘kalten’);
8) output all sentences containing the given part of speech;
9) output all sentences containing the given parts of speech (up to three parts of speech);
10) output all sentences containing the given morphological attributes of the tokens (e.g. the tense or the person, up to three attributes);
11) output all sentences containing the given values of the morphological attributes of the tokens (e.g. the past tense or the 1st person, up to three values);
Moreover, a number of technical parameters had to be taken into account to make the interface more friendly. This mainly concerned the activation and deactivation of the GUI objects or widgets. For example, one may not press the request button until a new linguistic corpus is opened.

It was assumed that the basic language of the corpus manager would be Russian. The translation of the interface into other languages would be possible.

According to the parameters of the model we have built the following graphical shell (Figure 1):

![Figure 1. Graphical shell for the corpus manager](Source: compiled by the authors.)

The menu bar is located at the top of the main window followed by the settings block with the Engage button at the bottom. Then the output area is situated. The most complex part is the settings block, which contains multiple check boxes that activate or deactivate related widgets. Other objects are Qt spin boxes, Qt combo boxes, Qt line edits, Qt push buttons and a Qt label.

To start working with the corpus manager the user must open a new linguistic corpus in the File > Open Corpus menu (Файл > Открыть корпус). The number of sentences and tokens in the current data base appears in the top left corner (e.g. Текущий корпус: amerikasql.db 4025 / 100230). Then the Engage button (Поехали!) becomes active, and a request can be launched. To output the given sentence in the context of several sentences one can switch on the sentences check box (ВКЛ ПДЛ) and input a number into the Qt spin box. The result appears in the output area. The programme is configured in such a way that the context includes five sentences before and five sentences after the given sentence.
To get the frequency list the user can click the Tools > Frequency list menu (Инструменты > Частотный список). For example, from “Amerika” we get the following (ten first lines are listed):

<table>
<thead>
<tr>
<th>Token</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>8844</td>
</tr>
<tr>
<td>der</td>
<td>6819</td>
</tr>
<tr>
<td>ich</td>
<td>5593</td>
</tr>
<tr>
<td>doublequote</td>
<td>2997</td>
</tr>
<tr>
<td>und</td>
<td>2476</td>
</tr>
<tr>
<td>sein</td>
<td>1933</td>
</tr>
<tr>
<td>sich</td>
<td>1855</td>
</tr>
<tr>
<td>haben</td>
<td>1260</td>
</tr>
<tr>
<td>Karl</td>
<td>1211</td>
</tr>
</tbody>
</table>

Here we see the so-called raw sorting according to spaCy rules, since there are also punctuation marks among the tokens. However, at position ten we notice the name of the main character Karl. All simple requests function in a similar way. The user switches on the checkbox, enters the data and gets the result. For the manual request two options for the beginning of the request text are foreseen: SELECT * FROM sents WHERE and SELECT * FROM tokens WHERE. The user needs to add the necessary parameters only. To clear the output area one should click the View > Clear the area menu (Вид > Очистить поле). The output area is an editable object, so the text can be easily copied from it with the hotkeys.

The complex requests are a little trickier. If one switches on a few checkboxes, enters the data into the appropriate input widgets and presses the Engage button, the programme performs all requests one by one as a simple sequence. To activate the complex request as a special procedure the corresponding checkbox in the top right corner (СВК УчТ) must be activated. After that four options become available.

If СВК УЧТ & ВКЛ АТР & ВКЛ ЗНЧ are checked and other checkboxes are unchecked, the programme selects the sentences that contain tokens with the given morphological attributes and values. For example, for the request Degree=Cmp & Case Dat in the demo corpus, which consists of 29 sentences, one gets the following result:

```
[Degree', 'Case'] : [Cmp', 'Dat'] : zum (Case=Dat); Übernachten (Case=Dat); früheren (Degree=Cmp) : 19 ; „Und man muß die Erlaubnis zum Übernachten haben?“ fragte K., als wolle er sich davon überzeugen, ob er die früheren Mitteilungen nicht vielleicht geträumt hätte.
Токенов: 3/0 (Tokens: 3/0)
Предложений: 1 (Sentences: 1)
Предложений всего: 29 (From Sentences: 29)
```

Here we receive sentence number 19 only, which includes tokens that match the request: the comparative degree (of adjective) and the dative case (of the preposition and the noun). Statistics are displayed at the end of each output. In this case it is the number of the tokens and sentences found and the total number of sentences in the corpus. 3/0 means that three tokens are found totally, but no token meets all the given parameters. Obviously, an adjective früheren can stay in the dative case, but in this
sentence it is used in the accusative case. Therefore, if one changes the request and inputs \textit{Degree=Cmp} \& \textit{Case Acc}, one gets the following result:

\begin{verbatim}
[Degree, Case]: [Cmp, Acc] : ihre (Case=Acc); Sessel (Case=Acc); besser (Degree=Cmp) : 12 : Die Bauern waren auch noch da, einige hatten ihre Sessel herumgedreht, um besser zu sehen und zu hören.
[Degree, Case]: [Cmp, Acc] : die (Case=Acc); Erlaubnis (Case=Acc); sich (Case=Acc); früheren (Degree=Cmp); früheren (Case=Acc); Mitteilungen (Case=Acc) : 19 : „Und man muß die Erlaubnis zum Übernachten haben?“ fragte K., als wolle er sich davon überzeugen, ob er die früheren Mitteilungen nicht vielleicht geträumt hätte.
\end{verbatim}

This time two sentences match the parameters, and one token has \textit{Degree=Cmp} \& \textit{Case Acc}. The second complex request is \textit{СВК УЧТ} \& \textit{ВКЛ ЧР} \& \textit{ВКЛ АТР} \& \textit{ВКЛ ЗНЧ}. The checkboxes must be set as shown below (Figure 2):

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{fig2.png}
\caption{Output for the request \textit{СВК УЧТ} \& \textit{ВКЛ ЧР} \& \textit{ВКЛ АТР} \& \textit{ВКЛ ЗНЧ}}
\end{figure}

Source: compiled by the authors.

In this case only one part of speech can be selected, but all three attribute \& value pairs are available. As it can be seen from our example, the programme has found sentences where the adjectives stay in the accusative.

The third and the fourth complex requests are \textit{СВК УЧТ} \& \textit{ВКЛ ЛЕМ} \& \textit{ВКЛ АТР} \& \textit{ВКЛ ЗНЧ} and \textit{СВК УЧТ} \& \textit{ВКЛ ТКН} \& \textit{ВКЛ АТР} \& \textit{ВКЛ ЗНЧ}. The difference between them and the second complex request is that instead of a part of speech, a lemma and a token are selected, and all three attribute \& value pairs are also available. In the case of lemma one can find all occurrences of a word in particular forms. For example for lemma=stehen \& attribute=Number \& value=Sing the output can be like this:

\begin{verbatim}
\end{verbatim}
In such a way one can separate homonyms from each other. For example, for
the English square one can get the following output by the simple lemma request (J. London’s corpus):

[square] : square : 2848 : “I’m going to have a square meal before I start,” Smoke said.
[square] : squared : 3100 : Smoke squared his shoulders and laughed non-committally.
[square] : square : 6758 : “A square deal!”
[square] : square : 6990 : He’s got about twenty thousand square miles of huntin' country here all his own.
[square] : square : 7288 : An’ he croaked one square through the chest.”

But for the request lemma=square & attribute=Tense & value=Past one gets
the verb squared only, and for lemma=square & attribute=Degree & value=Pos the
result will include three sentences with the adjectives. To get the noun the request
combination should be lemma=square & attribute=Number & value=Sing, because
spaCy does not assign number to the English adjectives.

**Discussion**

Thus, we have clearly stated that the GUI application operates within the given
parameters. Now it is necessary to evaluate critically the benefits of the work that
has been done and identify the fields, in which the created tool could be effectively
applied. First of all, it may be used for the fiction texts interpretation. Let us give
some examples.

Using the simple lemma request one can easily calculate the concentration
of the modal verbs (müssen, sollen, können, dürfen, wollen, mögen) among the
sentences in the given fiction work. We identify this parameter as the author’s
modal fingerprint, because it tends to be unique for every writer. Therefore, for
Kafka’s novels the concentration factor is equal to 30.7% (“The Castle”), 31.8%
(“The Trial”), 31.7% (“Amerika”), that is, they are almost identical.

We can also consider the grammatical category of the person in the novel “The
Castle”. The distribution between the 1st, 2nd and the 3rd person in the novel is the
following (Figure 3):

![Fig. 3. Distribution between the 1st, 2nd and the 3rd person in “The Castle”](source: compiled by the authors.)
If we hypothesize that such a distribution may influence subconsciously the reader’s perception of the novel, then these data contribute to the explanation, how the idea of alienation is expressed at the linguistic level.

The distribution between the tokens in the present and in the past allows one to analyze the temporal structure of a fiction text. Not to mention the fact that one can get the contexts of the author’s use of the certain language units or phenomena.

To be just, let us note that the critical point of using raw NLP libraries is that one always has to take into account the possibility of an error, which can lay, in our opinion, up to 20%.

An automatically generated tool can serve as a basis for more complex and advanced corpus research. If one alters slightly the proposed database structure by putting extra cells into the rows of the sentence and token tables, one could additionally mark up the corpus units, e.g., semantic or stylistic features. This would greatly enrich the analysis and open new prospects for the research.

From the point of view of linguodidactics, the proposed software may also be applied as a tool for compiling textbooks in such a complex discipline as Home Reading. Learning materials for it should contain various exercises, including grammatical training of certain phenomena, but based on the given fiction work text. For example, if one needs to study the construction *would* + *infinitive*, one can easily find sentences that contain it, applying a simple token request, and get the following output (J. London’s corpus):

```
[would] : would : 219 : He had not dreamed the invitation would be accepted.
[would] : would : 253 : Despite the fact that the Indian packers had jumped the freight from eight cents a pound to forty, they were swamped with the work, and it was plain that winter would catch the major portion of the outfits on the wrong side of the divide.
[would] : would : 277 : She was dressed as any woman travelling anywhere would be dressed.
```

The most interesting is the combination of several grammatical features in one sentence. For the German grammar it may be, e.g., the reflexive verbs and indefinite pronouns (“Amerika”):

```
[Reflex], [PronType] : [Yes], [Ind] : 1575 : Wir haben ihm unser Vertrauen geschenkt, haben ihn einen ganzen Tag mit uns geschleppt, haben dadurch zumindest einen halben Tag verloren und jetzt — weil ihn dort im Hotel irgend jemand gelockt hat — verabschiedet er sich, verabschiedet sich einfach.
```

Using various request options, the author of the learning materials can achieve the results he or she needs.

**Conclusions**

Let us conclude that an attempt to systematize and automate the work with linguistic corpora makes it possible to solve not only clearly defined and specific research tasks, but also opens the prospects of partial automation of the fiction texts.
interpretation. The partial automation of this procedure makes it possible to solve some particular research problems of the corpus linguistics. For example, the analysis of the gender factor, realized through the systematic use of the lexical and grammatical means.

Our research has yielded positive results. We have described the potential of spaCy NLP library for the fiction texts processing. The strengths of the library are its sentencizer, tokenizer, lemmatizer and morphologizer, though an error can reach up to 20%. The corpus parameters of the research have been determined. The language material has been organized as an SQL based linguistic corpus, what contributes to building a model of a technical device for creating and managing a structured fiction text array. Finally, we have developed and tested a beta version of a GUI application that is able to process several types of requests.

The development of special software for the fiction texts processing stimulates the search for scientific solutions and at the same time allows one to understand the essential differences that exist between natural and artificial intelligence.

References / Библиографический список


Information about the authors:

Alexey I. Gorozhanov, Dr.Sc. in Philology, Associate Professor, Professor of the Department of Grammar and History of the German Language, Faculty of German Language, Moscow State Linguistic University (38, b. 1, Ostozenka str., Moscow, Russian Federation, 119034); Research interests: German studies, applied linguistics, foreign language teaching; e-mail: a_gorozhanov@mail.ru
ORCID: 0000-0003-2280-1282; SPIN-code: 1753-4920, AuthorID: 592980.

Innara A. Guseynova, Dr.Sc. in Philology, Associate Professor, Vice-Rector, Moscow State Linguistic University (38, b. 1, Ostozenka str., Moscow, Russian Federation, 119034); Research interests: applied linguistics, media, lexicology; e-mail: guseynova@linguanet.ru
ORCID: 0000-0002-6544-699X; SPIN-code: 1635-5260, AuthorID: 662483.

Darya V. Stepanova, PhD in Philology, Associate Professor, Minsk State Linguistic University (21, Zakharova, Minsk, Belarus, 220034); Research interests: applied linguistics, Media Discourse, lexicography; e-mail: daryastepanova79@gmail.com
ORCID: 0000-0002-2857-4386; SPIN-code: 5291-8660, AuthorID: 1131273.